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Welcome From The Chief Editor
Well … if you’re reading this, we made it! Nope. The
poles didn’t shift. The planetary alignment didn’t rip
the earth apart or rip it from its orbit. The predicted
apocalypse seemed to pass us by. PHEW! Did we
perhaps dodge another bullet? I hardly think so.

So, have we dodged another apocalyptic bullet?
Perhaps, but we remain staring down the barrel of a
gun – at point blank range. I firmly believe that we –
the human race – will be the ultimate undoing of our
own kind, and of this planet. We treat one another
and our planet as if they are all as disposable as a
hot dog wrapper tossed to the ground. Overall, it
seems that mankind gets dumber and dumber with
every passing increment of time (go ahead and
choose your own increment – second, minute, hour,
day, week, month, year, decade, etc.). It’s not just
individuals, either. It’s a collective problem. As a
race, and in whatever small groups we form, human
beings seem to be less and less capable of making
good, sound decisions. Perhaps the information
overload that the information age delivered us has,
in fact, made us dumber. Maybe because we are so
overwhelmed by the enormous amount of available
information, we are unable to separate the wheat
from the chaff. Maybe we can no longer discern
what is important from what is unimportant, or what’s
right from what’s wrong.

Many other predictions have been made throughout
history, foretelling the “end of days” for mankind and
for our home among the cosmos. They have, as we
know, all come and gone with barely a notice. The
return of Halley’s Comet every 72 years brings out a
flurry of doomsayers. Even the appearance of the
HaleBopp comet in early 1997 brought about the
infamous Heaven’s Gate cult. They believed an alien
spaceship was hidden in the bright tail of the comet,
which was to serve as their “escape vehicle” before
the earth was “recycled” (wiped clean, renewed,
refurbished and rejuvenated). In order to gain
passage on the spaceship, they were convinced that
they had to commit suicide and ascend to a higher
plane. Police found the dead bodies of 39 members
of the cult.
Then the last “big apocalypse” was Y2K. Now, enter
2012 and the Mayan calendar. According to the
TGDaily website, amateur followers of the Mayan
"long count" calendar claim that the completion of a
time cycle known as Baktun 13 heralds the end of
the world as we know it. However, the Mayans also
believe that the Baktun 14 cycle will begin
immediately after the conclusion of Baktun 13.
Whatever.
Personally, I believe that they simply didn’t continue
their “long count” calendar past 2012 for two
reasons. First, the Mayans themselves may have
either believed that they themselves wouldn’t be
around, or that someone else would pick up their
work and continue it. Secondly, I’m sure at some
point, someone had to think “after 3000 years (or so)
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of this calendar, certainly someone in the 21st
century will be able to recognize a pattern here and
just repeat.”
My favorite take on the “end” of the Mayan “long
count” calendar is this cartoon. It’s quite conceivable
to me that this scenario could, very well, be the
entire reason that the Mayan “long count” calendar
ends when it does. My coworkers all get a chuckle,
because I have a copy of this cartoon fastened to
the outside of the door of my locker at the hospital.

So, in a sense, we haven’t dodged anything, and
certainly no bullet. The bullet is still in the gun, and
the gun is still pointed squarely at us. The “Great
Doomsday of 2012” will simply become yet another
footnote in a long list of apocalyptic events that were
supposed to see the end of life as we know it. If
nothing else, it gave us something else to focus on,
other than our own shortcomings as a species.
Sadly, it may have even prevented us from
addressing those shortcomings. I only hope that we
can (somehow) divert our attention back to fixing our
shortcomings.
Until next month, I bid you peace, happiness,
serenity and prosperity. Oh, and Happy New Year!
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Windows Migration:
Live Session & Installation

by agmg (Antonis Komis)

PCLinuxOS KDE 2012.08 LiveCD but they apply to
every version of PCLinuxOS.

In a previous article, you have learned how to
download, verify and create a CD, DVD or a USB
with PCLinuxOS. In this article, you will use this
medium to install PCLinuxOS to your hard disk,
either by creating a dual boot system (thus, keeping
your existing Windows installation), or by completely
wiping your disk and installing only PCLinuxOS to it.
But before doing that, how would you like to try the
new operating system without making any changes
to your computer? Sounds interesting? Keep on
reading.

One thing you should keep in mind is that a normal
LiveCD can’t save files or customizations you make
during the live session. Once you reboot your
computer, everything will return to its previous state.
There is an option to create a LiveCD that can save
files and remember your preferences. It is called
“persistence.” We will discuss this option later in this
article. For now, insert your LiveCD medium to your
computer, reboot, and be sure to select that medium
as your boot device. You will see a screen similar to
this:

wait for the live session to load. It may take some
time because the whole operating system is loading
to the computer memory. The procedure also
depends on the read speed of the CD/DVD/USB.
Once done, select your keyboard layout and you will
be presented with the PCLinuxOS desktop.

LiveCD
A LiveCD is a complete, bootable operating system
that runs in the computer’s memory (RAM) without
the need of a hard disk drive. Although this term is
used to describe all types of “live” operating
systems, the medium is not limited to a CD. You can
have a LiveCD running from a DVD, a USB flash
drive, an external hard disk or even a flash card, as
long as your computer supports it. The main purpose
of a LiveCD is to allow you to experience and
evaluate an operating system before installing it, but
can also be used to repair corrupted or infected
Windows installations, backup files from a dying
system and much more. A normal Windows CD or
DVD can’t offer you these possibilities.
In this section of the article we will cover just the
basics: boot from a PCLinuxOS LiveCD to a
complete desktop, connect to the internet, install a
couple of programs and experience it before
deciding whether or not to install it.
NOTE: The

screenshots

were
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taken

from

a

The default KDE LiveCD desktop

The LiveCD option will be selected (highlighted) by
default. Before booting, if you wish to change the
language to one other than American English, press
F2 and select a language. If you wish to change the
screen resolution from 800x600 to another, press
F3. If you have changed any options, select the
LiveCD option and press ENTER. Otherwise, simply

One of the first things you might want to configure in
your live session is your internet connection. This
will allow you to surf, check your emails, watch
online videos and install new programs through
PCLinuxOS’ package management software,
Synaptic. In the lower right corner of the desktop,
you can see the notification area showing the status
of your network connections, system volume,
removable devices and other notifications. If you are
using an ethernet connection to access the internet,
then it will most probably have already been
automatically configured. If you have a green check
mark, then you’re good to go. If you see a red X
mark, it means that your network connection isn’t
configured properly.
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3. Navigate to Local Disks > Manage Disk
Partitions.

If you are using an ethernet connection and still see
a red X mark, the best thing to do is visit the official
PCLinuxOS forum (www.pclinuxos.com/forum) to get
more help. If the connection is wireless, then you
need to enter your wireless network security key
before you can access the internet. To do that, left
click on the Network Manager to view your network
connections.

4. Select your USB drive from the tabs.

Synaptic Package Manager

management. Don’t be afraid. If something goes
wrong, you can always start a fresh live session.
Nothing will be changed on your computer and no
one will get hurt.

By pressing “Configure” you can view your
connection’s settings and set a security key if your
connection needs one. If you can’t see any network
connections in this window, then your network
adapter may not be configured properly. (Again, visit
the forum for more help).
If you like, you can have a look at PCLinuxOS’
package management program, Synaptic. You can
find it in the taskbar or in the menu under Software
Center. Synaptic is the proper way to install and
remove programs and keep your system uptodate
(center, top).
Click “Reload” to refresh the package list and then
“Mark All Upgrades” to update your live session.
Feel free to explore the available choices, install
some programs and get familiar with software
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Last but not least, you can use your current live
session to create a new LiveCD on a USB flash
drive or hard disk using a program designed
specifically for PCLinuxOS, the PCLinuxOS LiveUSB
Creator. You can find it in the programs menu under
More Applications > Configuration. This tool will
also allow you to create a Live USB with persistence
which will save your files and preferences even after
a reboot, provided there is enough disk space on the
drive. This way you can have a live system on which
you can install the programs you prefer, keep it
updated and use it on any computer you want.
Practically a whole operating system in your pocket!

5. Press “Toggle to expert mode”.
6. Select “Type”. From the window that pops up
select an ext filesystem (most commonly ext4 or
ext3).

Creating a LiveUSB with persistence (quick
guide)
1. While in the live session, insert a USB drive.
Ignore the Device Manager popup.
2. Navigate to More Applications > Configuration >
Configure Your
Computer
(or
press
the
corresponding icon in the panel).
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7. Back in the main window, press “Format” to format
the drive with the new filesystem.

17. The script will then ask you to locate the file
livecd.sqfs. From the window that pops up, select
“File System” (from the “Places” pane on the left)
then navigate to initrd > cdrom and select the file
livecd.sqfs.

8. When formatting is finished, press “Done”, remove
the drive and close all windows.
9. Again, navigate to More Applications
Configuration > PCLinuxOS LiveUSB Creator.

>

10. After the welcome screen, you will be asked if
you want to run the script as root. Select “Yes” and
type the root password of the live session, which is
“root”.
11. Plug in your USB drive when prompted.
12. The script will scan the drive and present a
window with information about the partitions that are
currently on the disk.

15. In the next window select the second option to
use the files of the Live CD or USB from which the
live session is running.

18. Confirm your selection and let the script finish.

16. Give a name for your LiveUSB and press “OK”.

19. In the next confirmation window you will be
asked about the Boot options. The “Standard live
boot option” will be selected by default. To enable
persistence you have to select also “Boot with
Persistence”. The option “Copy to RAM” will load the
whole operating system (making it faster provided
you have enough RAM available) while the option
“Memory Test” will add an entry for memtest
(memory testing program) in the boot menu.

13. Select the desired partition and press “OK”.
14. The next window will ask you whether you want
to create a new Live OS on the USB drive or add a
second or subsequent OS to it (if there is already
one or more OS). This is the first time we use this
tool so select the first option.
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20. The final screen is about the GRUB options. If
this is the first installation to the USB drive, select
Install Grub to the MBR. If you are managing your
own bootloader, select one of the other two options,
depending on your preference.

to select during boot which operating system you
want to use. This is the most common scenario for
users who are making their first steps in the Linux
world because it gives the ability to explore Linux
and come back to Windows anytime you feel like or
need to. This is the scenario we are going to cover in
this article. If you are planning to completely remove
Windows from your disk, you can go straight to
“Stepbystep installation”.
Preparing your hard disk

Congratulations! You now have a PCLinuxOS
LiveUSB with persistence enabled.

We will use a Windows 7 installation as an example
for the illustrations. The Disk Management software
can also be found in Windows XP and Windows
Vista. You can also use thirdparty partitioning
software for this job. A very nice program which has
a free version for home use (and I personally
recommend) is EASEUS Partition Master Home
Edition

Because the FAT32 and NTFS file systems are so
prone to fragmentation, it’s strongly recommended
that you defragment your Windows drive before
proceeding. Some recommend running the defrag
program three (3) times, consecutively. This will help
insure that you don’t experience any data loss with
your Windows files.
In this window you can see all the disks and their
partitions. In the example, we have a 50 GB hard
disk containing 2 partitions: the first one has a size
of 100MB (System Reserved) and is always created
during Windows 7 setup for system use. This
partition has to be intact to ensure the flawless
operation of Windows. The second one (C:) has
49.90GB size and is the main partition where
Windows and programs are installed. We will reduce
the size of this partition and make space to install
PCLinuxOS. Select this partition, right click on it and
select “Shrink”. You will get to the next screen.

For Windows XP:
Navigate to Control Panel > Performance and
Maintenance > Administrative Tools > Computer
Management > Disk Management
For Windows Vista/7
Navigate to Control Panel > System and Security >
Administrative Tools > Computer Management >
Disk Management
When you feel ready and have decided to install
PCLinuxOS on your hard disk proceed to the next
section of this article.
Installation
Before proceeding with the installation, you must
decide if you want to keep your existing Windows
installation, or whether to completely wipe the disk
and only have PCLinuxOS installed on it. The first
scenario is known as “dual boot,” and will allow you
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This window shows the total size of your partition
and the size of the available shrink space. There is
no magic recipe about how much space you should
spare for your PCLinuxOS installation. It depends on
the size of your disk and the files on it (which in turn
defines the available shrink space) and how you are
planning to use Linux (more programs and files,
mean more space). In general, Linux uses much
less space than Windows and separates installation
files and applications (root partition or /) from users
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files (home partition or /home). In this example, I will
use all the available space (around 25GB) with a
plan to devote 8GB for the root partition (installation
and applications), 2GB for /swap (virtual memory)
and the rest for /home (for personal and
configuration files). Select the desired size and
press “Shrink”.

NOTE: The screenshots were taken from a
PCLinuxOS KDE 2012.08 installation but the wizard
works in the same way for every version of
PCLinuxOS.

This screen is similar to the one in Windows Disk
Management. It shows all the available disks and
their partitions and presents the installation options. I
will explain each one of them:

The first screen you will see will look like this:

Use free space
This option will use the partition we created earlier
and will create 3 new partitions: one for root (/), one
for swap (/swap) and one for home (/home),
depending on your partition’s size and your
computer’s available memory (RAM). This option is
recommended if you are not very familiar with
partitioning.
Use the free space on a Microsoft Windows
partition
This option is used to create a partition in the free
space of an existing Windows partition. We won’t
use this option as we have already prepared a
partition for our PCLinuxOS installation.

Now there is one more partition in your hard disk
that reads “Unallocated.” This means that it hasn’t
been formatted with a file system yet, so it’s just
unused space (that’s why there is no drive letter for
it). We are done here. It is time to go back to our
Live CD/DVD/USB and install PCLinuxOS. Don’t
worry, it’s as easy as 1,2,3!
Step by step installation
Before rebooting, ensure that you have inserted your
Live CD/DVD/USB and your computer is set to boot
from it. When the boot menu appears, select “Install
PCLinuxOS” to begin the installation wizard. Of
course, you can start a live session as discussed in
the beginning of this article and then proceed with
the installation by clicking on the “Install
PCLinuxOS” icon on your desktop. I suggest you
select the US Keyboard for the installation (you can
change it later and add new layouts very easily).
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Press “Next” to get to the next screen:

Erase and use entire disk
Selfexplanatory. Windows will be deleted from the
disk and all free space will be used by PCLinuxOS.
Custom disk partitioning
This option is the most advanced and gives you
absolute control over the partitioning procedure. We
will have a more thorough look at this option right
away.
In this screen (next page, top left) we can see all the
partitions we have previously created. If you click in
each partition, you will get detailed information about
that partition. The first partition on the left is the
Windows system partition (100 MB). It is showing as
a thin line because its size is very small compared to
the other two.
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The next partition is the main Windows partition.

CAUTION: selecting this option and then pressing
“Done” can’t be reverted.
EXTREME CAUTION: If you click on “Clear all”
all the partitions will be removed and all data on
the disk will be lost!
Select Create to move on to the next screen.

If you decide to manually set your partitions, you
should do a further reading about the Linux
filesystem and the definition of a mount point to fully
understand what you are doing. Some links that
might help:
Linux Filesystem explained:
http://www.freeos.com/node/36
Linux Mount Point:
http://www.linfo.org/mount_point.html
Types of Linux filesystems:
http://www.kernel.org/doc/man
pages/online/pages/man5/filesystems.5.html
For the purpose of this article I will create three
partitions to use as mount points for root (/), swap
(/swap) and home (/home)... (next page, left)

The last partition is the one we created for
PCLinuxOS and this is the one we will work on
(center top).
You can see that this partition is empty and its size is
24 GB. If we click on Auto Allocate, the setup wizard
will automatically create the partitions in a way
similar to the option “Use free space” in the previous
screen.
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This is how our partitions will look in the end (next
page, center):
In this screen you have the option to set the size of
your Linux partition, its filesystem type and its mount
point. You can also set disk encryption if you need to
(top right).

If you are not satisfied with the partitioning result,
you can delete the partitions and create new ones or
resize them according to your needs. Just remember
to always select the partition you have created for
this purpose and don’t make any changes to the
Windows partitions.
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At this point, the installation wizard is copying files to
your computer. When it finishes, you will be
presented with the next screen:

When you are ready to proceed, click “Done”.
In this screen you can select the bootloader to use
for your new installation, the device (partition) where
is will be installed, the time it will show before
booting the default option and whether or not you
want to secure it with a password.

You will see a warning that the partitions are going to
be formatted. Installation will begin when you click
“Next”.

A bootloader is a piece of code that runs before the
operating system(s), and gives you the ability to boot
other operating systems too. The default bootloader
for PCLinuxOS is GRUB and replaces the Windows
bootloader in a dualboot scenario (Windows
bootloader doesn’t allow other operating systems to
be booted from it). By default, GRUB is installed on
the MBR (Master Boot Record) of the disk but if you
have multiple installations on different partitions, you
may need to modify this setting. You can also select
to secure your bootloader with a password to
prevent users from entering single user mode or
changing settings at boot time.
I have used the default options in this installation.
Only thing I have tweaked is the GRUB delay before
booting the default image, from 10 to 5 (boot menu
will appear for 5 seconds on the screen instead of
10). (next page, top left)
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When you click “Finish”, the setup wizard will prompt
you to remove the LiveCD media and reboot your
computer.

In the next screen you will review the entries of your
boot menu so far. You can add, modify or remove
any one of them. For example, you may want to use
Windows as the default boot operating system.
Select the entry named “windows” and click “Modify”.
Check the box that reads “Default”.

You could also put Windows first in the boot menu if
you want to. Again, select the entry and change its
position with the up and down arrows (center top).
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The other three entries are standard in every
installation of PCLinuxOS:
linux (/boot/vmlinuz)
This is the default boot option for PCLinuxOS. It will
appear as “Boot PCLinuxOS”.
failsafe(/boot/vmlinuz)
This entry is similar to Windows Safe Mode (but
much more powerful). It can be used in case an
update or a configuration change causes an error
which prevents your system from starting properly. It
boots into a very minimal environment (only the
shell, with no system services, external drivers or
desktop loaded) and helps diagnose and repair the
problem which is causing the problem. It will appear
as “Boot PCLinuxOS (safe mode)”.

Setup has practically finished. PCLinuxOS is
installed on your computer. Just a few more
configuration steps and we’re done.
When the computer reboots, you will see the boot
menu we discussed previously. If you have modified
the entry for Windows and have set it first and
default, you will have a boot menu similar to the
following:

linuxnonfb(/boot/vmlinuz)
This entry is for booting the system without using the
Framebuffer driver. Framebuffer mode utilizes the
vesa capabilities of your video card for displaying
graphics. This option is used for troubleshooting
problems related to that mode. The Graphical Boot
Menu (GRUB) is displayed in your screen using the
Framebuffer driver. So, if you are seeing GRUB,
there is no reason to worry! This entry won’t appear
in your boot menu (you can hit Escape to go to "text"
mode and see all 3 options).
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Select “Boot PCLinuxOS”. When the operating
system finishes loading, you will be prompted to
select your timezone and adjust your date, clock and
timezone settings:

when you install new software, update your system,
modify system settings etc. It is recommended to
have a unique password for your root account.

The final step is the user creation screen.

Next step is to create the root account and set a
password for it. Root account is a special user
account used for system administration (similar to
Windows Administrator). Root (or superuser) is the
user who has all rights or permissions (to all files
and programs) in all modes (single or multiuser).
You will need root access in many occasions like
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The first thing you must do after login is run a full
system update (a reminder will appear the first time
you login). Once you do that, you are free to explore
the new and amazing world of PCLinuxOS!
Welcome!

Fill in your details, set a strong password (it is
recommended to have a different password from the
root account) and continue to the login screen. You
can add more users later by going to More
Applications > Configure Your Computer > System
> Manage users on the system (top right).
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Available in the following desktops:
KDE

Gnome

LXDE

Xfce

Enlightenment e17
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Posted by cstrike77, December 19, 2012, running KDE4.
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Windows Migration: Keeping Your System
Up To Date & Installing Software

by Paul Arnote (parnote)

Windows world, I’ve often heard this referred to as
“DLLHell.”

I, like many other Linux users, am a former Windows
user. There are very few Linux users who didn’t take
this path to Linux. Under Linux, I had to learn some
new ways of doing things. Well, alright … they
weren’t exactly “new,” but they were definitely “new”
to me. One of those things was installing software
and how to keep my system uptodate.

Now raise your hands – how many people reading
this article have done one of the things in the
following list?

The Windows Way

1. Allowed your computer to automatically apply
Windows updates and came back to your computer
where something wasn’t working correctly, due to an
improperly applied patch.

One thing that you will find that is different under
Linux is how you install software. Using the Windows
way to install software, you would either insert a CD
or DVD containing your software or download the
software from the Internet. You would then proceed
to install that software from either your CD/DVD, or
from the installer that you downloaded from the
Internet. When the process is through, you
(hopefully) have your new software application
installed – and hopefully, it works and nothing else
was installed along with it.
Unfortunately for most people, this method of
installing software under Windows is fraught with
problems. First, there is the security aspect. Any one
of the CD/DVDs or any one of the downloaded
installers can easily introduce viruses, malware,
crapware, or spyware to your computer.
Secondly, installing one software package could
cause some other installed software applications to
suddenly stop working. This occurs when key
system files and libraries are changed for one
application, but the other installed software
applications are reliant on an older version. In the
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Windows updates are handled in a similar fashion. I
know that most Windows users I’ve met (and I know
a LOT of them) dread Tuesdays. Even I dreaded
Tuesdays when I was a Windows user. Why
Tuesdays? Because that is the day of the week that
Microsoft pushes out Windows updates. Even in the
tech journals, it’s referred to as either “Microsoft
Patch Tuesdays” or “Update Tuesdays.”

2. Blindly (and manually) applied all patches from
Microsoft, without knowing what patches were being
applied.

Third, since the installers are closed to prying eyes
(in a feeble attempt to “keep the installer secure”)
and you really have no idea of what you are
installing, it’s easy (and unfortunately common) for
software vendors in the Windows world to make
agreements to include additional software (often
from nefarious sources that you wouldn’t download
from, anyway) that is automatically installed on your
computer. This is usually software that you either
don’t want or didn’t ask to be installed. These are
often things like unnecessary and unwanted browser
toolbars, some of which may literally hijack your web
browser, and some of which may be next to
impossible to remove completely.

3. Manually verify each and every patch before
applying it (requires selecting either the advanced or
custom option, depending on how they are wording
it that week), and selected which of the patches to
apply, and which of the patches to permanently
ignore.
4. Turn off automatic updates, permanently.
If I had a $5 bill for every time Microsoft released a
bad patch and had to roll that patch back to a
previous version (provided your computer still
worked), I’d be a rich man. Unfortunately, Microsoft
doesn’t pay us for such inconveniences and wastes
of our time.
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The PCLinuxOS Way
Even though it may seem foreign at first, Linux does
things differently. Having experienced both the
Windows way of doing things and the Linux way of
doing things, I can tell you from first hand
experience that the Linux way is much better – and
a much more secure way of doing software updates
and installations. Just as Linux itself is distributed
freely, the vast majority of software applications,
libraries and drivers are also available for free.
Under PCLinuxOS, as with nearly every other Linux
distro, software and updates are handled and
controlled from a central software repository. What is
a repository? A repository is a collection of software
applications, support libraries and drivers. Special
care has been taken to insure that everything works
on as wide of a variety of systems as possible,
without breaking other applications in the process. In
the rare but occasional event that two software
packages are incompatible with one another, the
user is given a choice to either uninstall the
previously installed software package, or to abort the
installation of the new software package. Essentially,
almost every application and library in the
PCLinuxOS repository has been custom built to
PCLinuxOS specifications (to insure that your
computer remains stable), and has been custom
built to insure that all of the applications work
seamlessly together.
Furthermore, the PCLinuxOS way (and not the way
of every Linux distro, by the way) is to NOT – never,
ever – install software that from outside of the official
repos. Installing from outside the official PCLinuxOS
repository can be a dicey proposition, even for
seasoned Linux users. Great amounts of time and
care have been invested to make sure that
everything in the official PCLinuxOS repository
works well with everything else. This helps keep
your system stable over the long haul.
That stability comes in the form of making sure that
when you install one software application, it doesn’t
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break other installed software packages. Once
you’ve installed from outside of the official repository,
you render your PCLinuxOS installation as ineligible
for support on the forum. Why? Doesn’t this seem
harsh?
Not really. Once you’ve installed packages that are
from outside sources, there is no way for the
PCLinuxOS developers or other PCLinuxOS users
(upon whom you are relying for support and
assistance, via the forum) to know all the changes
that were made to your system. They don’t know
what additional files were added to your system that
might be conflicting with the approved PCLinuxOS
libraries and software. They don’t know what vital
libraries and software packages were replaced by
newer or different versions that aren’t 100%
compatible with the software and libraries installed
on your system. Basically, because no one knows
what changes have occurred to your system, it
makes it next to impossible to track down exactly
where the problem lies. Only when software
packages have been custom built and made for
PCLinuxOS by the PCLinuxOS developers can we
fully know and understand what changes are made
to your system when they are installed.
Currently, there are over 13,300 individual software
packages available for installation in the official
PCLinuxOS repositories. Each of those software
packages have been vigorously tested to insure that
everything works together as it should. There are
also (currently, at the time I’m writing this article)
around 150 additional software packages in a
special testing section of the repositories that
advanced PCLinuxOS users who have signed up as
testers can test, before it is released to the general
PCLinuxOS users. The number of software
packages in testing is likely to vary from time to time,
sometimes widely, depending on what it is that the
PCLinuxOS developers are currently working on and
testing. Only “advanced users” who really know
what they are doing should ever install applications
from testing, and never on an installation that you
rely on for your everyday computing needs.

So what happens when there’s a software
application you need, but it’s not in the official
PCLinuxOS repositories? Fortunately, there is a
special section of the PCLinuxOS forum, called
“New Package Requests.” Once you have 10 posts
in the PCLinuxOS forum, this special section of the
PCLinuxOS forum will be opened up to you. Until
then, it will remain hidden from your view.

After you’ve read the guidelines for making a
package request, post your request in the
appropriate board. Now, just sit back and wait. Other
PCLinuxOS community members will come along
and give your request a “+1” if they agree that it
needs to be added to the PCLinuxOS repositories.
Discussion of suggested packages is NOT allowed;
that’s something that better fits into the realm of
discussions that exist in the Software Discussions
section of the forum. Don’t take offense if someone
doesn’t agree with you about a software package
being added to the PCLinuxOS repositories. This is
a community, and not all members of a community
necessarily agree on all things (just like in real life).
Sometimes, one of the PCLinuxOS packagers will
see the request before anyone has responded to it,
will build it into an RPM package file, and send it
upstream to the repository maintainer (currently,
Neal Brooks, a.k.a. Neal ManBear).
The repository maintainer – who also happens to be
the lead developer – has the responsibility of
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deciding what section of the repository that software
packages are sent to, as well as making sure that it
is packaged properly. If the software package
doesn’t impact other applications and libraries, it will
sometimes go straight to the repos. Otherwise (and
this happens with most new packages), it will go to
the testers to make sure that it works as it should,
and that it doesn’t have any unintended bad effects
or bugs. Then, once sufficient time and testing has
elapsed, and once there is a high level of certainty
that the new package works as it should, without
breaking other applications in the repository, the new
package is released for general, everyday
PCLinuxOS users to download and use.
How To Update Your System
PCLinuxOS, like most every other Linux distribution,
uses a package manager to not only install
applications, but to also update your system.
PCLinuxOS uses Synaptic as its package manager.
Synaptic is a graphical front end to the aptget
command on the command line (insulating you from
the command line). Unless you are well versed in
the Linux command line, as well as PCLinuxOS’s
use of the aptget command set, it’s best to simply
stick with using Synaptic.

When you first launch Synaptic, you will need to
provide the root user’s password. This helps provide
another layer of security. Since all software additions
from Synaptic are available to all users on the
system, this prevents regular users from making
systemwide changes unless they know the root
user’s password.
After successfully entering the root user’s password,
Synaptic will launch. You will see something quite
similar to what is pictured below. In fact, one of your
very first actions after installing PCLinuxOS should
be to run Synaptic and apply any and all updates
available for your system. This will help not only
keep your system running at its peak, but it will also
insure that you have the latest versions of all
installed software. Having the latest versions of your
software helps eliminate security vulnerabilities and
makes sure that the software you are running has

the latest “fixes” for any problems that might have
previously existed.
You should choose the PCLinuxOS repository mirror
that is either closest to you, or the one that offers
you the best performance (typically, only discernable
by trying it out). Also, you should only ever choose
ONE repository to use. Never choose multiple
repository mirrors (with one minor exception). Why?
Because different mirrors sync at different times
from the PCLinuxOS master repository (at
ibiblio.org), and you will end up with conflicting
packages available. Those conflicts could include
dependency conflicts (the other applications and
libraries that the application depends on to work).
Also, you should avoid choosing the main repository
at ibiblio.org. That is the “master” repository, and all
of the other repository mirrors are synced from it. If

(Editor’s Note: In the following screenshots of Synaptic
“in action,” only the contents of the windows are being
displayed. The window title bar and frame have been
cropped out. This is because, regardless of which desktop
environment, icon theme, or window decorations you are
using, Synaptic will appear essentially the same.)
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date list of available software packages available.
Because PCLinuxOS is what’s known as a “rolling
release,” software updates are made available just
as soon as they are packaged and have passed the
testing procedure. On other Linux distros, the
software updates are sometimes “held back” until
the next scheduled release cycle.
As long as you regularly update your PCLinuxOS
system, you will always have the most current and
up to date version, and you will avoid having to
reinstall every time a new PCLinuxOS Live CD is
released. How often should you “regularly” update?
Some recommend once a week. Others recommend
once every two weeks. Minimally, you shouldn’t go
more than a month without checking for updates.
The longer you wait before checking for updates, the
more packages will have been updated. The more
packages there are to update, the longer it will take
to download and apply those updates. Conversely, if
you you update every week, the number of available
updates will be smaller, and the time involved in
downloading and installing those updates will also
be shorter. Plus, you will always have one of the
most up to date PCLinuxOS systems around.
you – and 50 other users – are using it as their main
repository from which to apply routine updates, your
consumption of bandwidth may delay and slow down
of the syncing of the repository mirrors.
Notice that I did say that there was one minor
exception. In addition to a “regular” PCLinuxOS
repository mirror, it is perfectly fine to also
simultaneously enable the special “megagames”
repository. Due to their size, many of the larger
games available under PCLinuxOS are kept and
maintained in their own special repository. This helps
preserve bandwidth for other users who may not be
into “gaming,” preventing the other repository mirrors
from being bogged down by others downloading the
large game files.
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When you first open Synaptic (and every time after
changing your repository mirror), you should click on
the “Reload” button (far left) on the Synaptic toolbar.
You will see a window similar to the one displayed
above. This insures that you have the most up to

Next, you should click on the “Mark All Updates”
button (second from the left) on the Synaptic toolbar.
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You will see a window similar to the one above.
Synaptic will list the applications installed on your
system that have newer versions. At this point, just
click on the “Mark” button at the lower right of the
above dialog box.

Now, click on the “Apply” button on the Synaptic
toolbar (third from the left). You will see another
dialog box (above) appear, asking you to confirm
your choices. Simply click on the “Apply” button in
the lower right corner of the dialog box to start the
update process.

You should now see a dialog box similar to the one
above, displaying a progress bar of the progress for
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the downloading of the updated files. If you wish,
you can watch the progress of individual files
download by clicking on the small triangle pointer
next to “Show progress of single files.”

Once all the files have been downloaded, Synaptic
will automatically install all of your downloaded
updates. A dialog box similar to the one shown
above should appear. The top progress bar
represents the progress for the specified file, while
the bottom progress bar represents the overall
progress for installation of all of the downloaded
updates. When both progress bars have extended
the full width across the window (as above), and all
updates have been installed, the dialog box will
close itself. You will then be returned to the original
Synaptic window.
Voila! Your PCLinuxOS installation is now fully upto
date.
Installing “Other” Applications
Once you have your freshly installed PCLinuxOS
fully updated, it’s now time to check out what other
applications exist that you may want to use.
Granted, most PCLinuxOS versions come with a
fully complete set of “other” applications ready for
you to use. Yet given the varied and individual needs
of any set of computer users, there’s no way to
anticipate what every user will want or need. So,
PCLinuxOS comes with a wide assortment of the
most popular applications preinstalled, which helps
users get up and running right out of the blocks.
Certainly, there will be software applications that you
will want to install, and you will certainly have
different desires and needs than other users.

Thankfully, you can choose to install from over
13,000 software packages that are in the
PCLinuxOS repository. Just like PCLinuxOS, all of
the software titles in the PCLinuxOS repository are
also free, open source software.
I can assure you that you can find applications to
perform nearly any task you might be able to
imagine, right in the PCLinuxOS repository. One
user may prefer to use Amarok (a music playing
application for KDE), while another may have a
preference for Clementine or DeaDBeeF (two other
music playing applications). Yes, they are all in the
PCLinuxOS repository, and all are awaiting your
installation, if you choose.
If you are brand new to Linux, I recommend taking a
little time to browse through the PCLinuxOS
repository to see what all might be available. Don’t
worry – nothing is installed until you apply your
changes (exactly as we did when we performed
updates in the last section of the article).
If you click on the “Sections” button in the lower left
corner of the main Synaptic window, you will see the
left pane of the Synaptic window list a myriad of
categories, or sections, for the available software
packages. Select a section that interests you, then
click on one of the software packages listed in the
top right window. When you do, a brief description of
the software package appears in the window at the
bottom right of the main Synaptic window.
If you want to install that software package, right
click on the package name and choose “Mark for
Installation” from the context menu that pops up.
Repeat this procedure for each software package
you want to install. If you accidentally select a
package that you don’t want – or if you change your
mind about installing it – simply right click on it
again, but this time choose “Unmark” from the
context menu. The software package will be
removed from the list of items to download and
install.
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Occasionally, you will receive a dialog box with extra
information after the installation of a software
package, or after applying updates. If that
information is labeled as a “Warning,” simply note
what the message is and move on. The vast majority
of the time, those “Warnings” are to let you know
what additional actions were taken to install a
software package, and can be safely ignored.
However, if the information is labeled as an “Error,”
take special notice of what the error message says.
Often times, it occurs because all of the packages
you marked for installation can’t be downloaded and
installed from the selected mirror (maybe the
mirror’s server was updating from ibiblio.org and
was unreachable). If Synaptic ever pops up a dialog
box asking if you want to continue ignoring those
software packages that could not be downloaded,
always select NO! If you select “Yes,” Synaptic will
continue to ignore those packages (and any
subsequent updates) forever. It will, simply, do as
you tell it to do. Simply wait a few minutes (10 or 15
minutes should do), and click on the “Apply” button
again to finish the download and installation of your
updates or software package installations.
When you have finished selecting the software
packages you want to install, click on the “Apply”
button on the Synaptic toolbar (third icon from the
left), and click on the “Apply” button in the dialog box
that pops up. Sit back and wait while Synaptic
downloads and installs your chosen software
packages. The procedure is exactly the same as
what was described in the earlier section of the
article, when we applied the updates to our system.
Sometimes, you have an idea of what you are
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wanting to install. Instead of trying to find it in the list
of over 13,000 software packages, you can search
through Synaptic’s list to find the application you
want to install. Simply select the “Search” button on
the Synaptic toolbar, and type in some identifying
information (name, genre, etc.) for the software you
are wanting to install, followed by clicking on the
“Search” button in the lower right hand corner of the
search dialog box. Synaptic will then list all of the
software packages that meet your search criteria.
Don’t worry if your search results don’t immediately
net results. Just change your search criteria a little
bit. Sometimes, the packager used different
terminology or language in either the name or
description. Select the software package(s) that you
want to install, and proceed as described earlier for
marking them for installation and applying those
software packages to your PCLinuxOS installation.

Summary
Overall, you should find it fairly easy to keep your
system uptodate. You should also find it very easy
to install software. One thing that is nice about
PCLinuxOS – and Linux, in general – is that you can
install whatever software you need, without breaking
your bank. Remember that if a software application
isn’t available in the PCLinuxOS repository, you can
make a suggestion to add it in the PCLinuxOS
forum. Just be sure that a Linux version of the
software exists, and that it can be freely distributed.
With this, you’ve just took another big step down
your Linux path, and on your path to greater
freedom from closed source, proprietary, costly
software. We think you will like what you find here.
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Crow
Respected Forum Elder
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How Crow sees himself

Crow loves to cook
and share his recipes

Crow posting in the Sandbox

Crow secretly analyzes
Forum members
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Mark's Quick Gimp Tip & Double Take

Mark's Quick Gimp Tip

As a cartoonist, I sometimes
wish I had drawn some
element of a cartoon a bit
differently. In order to make
that change, it means pulling
out a new piece of paper, redrawing the
entire cartoon, drawing that one element
slightly different, rescanning, and digitally
saving this result. Or, I can just use Gimp.
For instance, let's say I wanted the sail in
this cartoon to be a bit more “cartoony.”
Well, rather than redraw the entire toon, I
can simply use Gimp's Cage Transform
Tool. The tool is great for making changes
to perspective errors in photos, but can also
be used for just about anything. Select the

Cage Transform Tool (the icon
is a grid with dots), then draw
around the area you wish to
transform. The more selection
points you create, the more
you'll be able to refine the
shape.
Then, move those
points and let Cage Transform
do the rest.
When you're
satisfied with the result, hit the
return key to accept the
changes.
Mark Szorady is a nationally
syndicated cartoonist with
georgetoon.com. He blogs at
georgetoon.com/blog.
Email Mark at
georgetoon@gmail.com.

©2013 by Mark Szorady. Distributed by georgetoon.com
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Support PCLinuxOS! Get Your Official

PCLinuxOS

Merchandise Today!
Posted by Jokerface, December 5, 2012, running LXDE.
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Installing & Using Mailfilter
by YouCanToo (David Moore)
What is Mailfilter?
Mailfilter is a program that filters your incoming e
mail to help remove spam. Mailfilter is a very flexible
utility for UNIX (like) operating systems to get rid of
unwanted email messages, before having to go
through the trouble of downloading them to the local
computer. It offers support for one or many POP3
accounts, and is especially useful for dialup
connections via modem, ISDN, etc.
Who needs Mailfilter?
You do. With Mailfilter you can define your own
filters (rules) to determine which emails should be
delivered and which are considered waste. Rules
are regular expressions, so you can make use of
familiar options from other mail delivery programs,
such as e.g. procmail. If you do not get your mail
from a POP3Server, you don't need Mailfilter.
How do I install Mailfilter?
Open the Synaptic package manager, do a search
for mailfilter, mark it for installation, and click apply to
install it.
How do I configure Mailfilter?
There are a couple of files that will need to be
created in your home directory.
1. The first file is the mailfilter log file. To create the
mailfilter log file open a console window and type in
the following command:
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[dwmoar@laptop ~]$ touch mailfilterlog
<press return/enter>
An alternative to using the command line is to use
your favorite text editor and create a blank file. Save
the file to your home directory.

Now we need to change permission of the newly
created file. Type in:
[dwmoar@laptop
~]$
chmod
744
mailfilterlog <press return/enter>

An alternative to using the command line is to open
Dolphin and locate your newly made file. Right click
on the mailfilterlog file and choose properties >
Permissions > Advanced Permissions. Make sure
the following are marked.
User
Group
Others

Read
X
X
X

Write
X
X
X

Execute
X

2. Now we need the .mailfilterrc file. Here is a basic
copy of the .mailfilterrc file to use. NOTE: This file
has the "TEST" flag set to true (on). The "TEST"
allows you to test your filters without deleting your
email should a filter be misbehaving. Think of it as a
safety net while trying out your filters.
This file needs to be placed in your home directory.
Save this file as ".mailfilterrc." NOTE the dot before
mailfilterrc. This is a hidden file and is required for
mailfilter to operate. Once you have saved this file,
you will need to edit it.
In your favorite text editor, open the .mailfilterrc file.

For our example, We are using nano in a console
window.
[dwmoar@laptop ~]$ nano .mailfilterrc

The minimum editing needed to get Mailfilter to
operate is the information for the email server,
username and password. Find the following lines in
your .mailfilterrc file
SERVER
= "Your email server"
<
usually starts with pop.domainname or
mail.domainname
USER
= "Your email username"
PASS
= "Your email password"
PROTOCOL = "pop3"
PORT
= 110
Warning! DO NOT change the order of the entries.
If you do, Mailfilter will not run.

Once you have changed the above to reflect your
information, save the .mailfilterrc file. At this point,
Mailfilter has enough information to run. Let’s give it
a spin. Open a console window and type in the
following. Don't worry … we are in a testing mode
and this WILL NOT change or remove any of your
emails.
[youcantoo@laptop
~]$
<press return/enter>

mailfilter

You should see something like this:
[youcantoo@laptop ~]$ mailfilter
mailfilter: 0.8.2 querying <my email
address> on Sun May 29 23:29:50 2011.
mailfilter: Examining 7 message(s).
mailfilter: Pass: Dianne
<forgivn@xxxnet.net>: Re: changed to
motorcycle fixed yet, Sun, 29 May 2011
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22:47:23 0500 [Score: 0].
mailfilter: Pass: Dianne
<forgivn@xxxnet.net>: Re: a cute
little game to play, Sun, 29 May 2011
22:53:32 0500 [Score: 0].
mailfilter: Pass: diannek
<forgivn@xxxnet.net>: [Recipies ~VIA~
the Web!] New Recipe Submitted!, Sun,
29 May 2011 21:37:48 0700 [Score: 0].
mailfilter: Pass: "Kitchen Krafts"
<newsletter@kitxxxkrafts.com>: Savings
celebration for Memorial Day!, Mon, 30
May 2011 00:10:00 0400 [Score: 0].
mailfilter: Pass: diannek
<forgivn@fxxxnet.net>: [Recipies ~VIA~
the Web!] New Recipe Submitted!, Sun,
29 May 2011 21:49:02 0700 [Score: 0].
mailfilter: Pass: Dianne
<forgivn@xxxnet.net>: Hotmail thinks
you are suspicious :), Sun, 29 May
2011 23:55:08 0500 [Score: 0].
mailfilter: Deny: Conley Erin
<erconleyin@gmail.com>:
=?GB2312?B?uaTStbrN0MXPoruvsr+52NPavtm
w7KGwxNq12NbQ0KHG8w==?=
=?GB2312?B?0rXJz8rQyNrXytPr0MLI/bDludL
FxrGovNvKtc7xstnX97jfvLbR0A==?=
=?GB2312?B?zNaw4KGwtcTNqNaqIDYuMjSjqMT
PvqmjqSA3LjExo6ixsb6po6nVxcu8?=
=?GB2312?B?1LQ=?= , Mon, 30 May 2011
14:30:29 +0800 [Maxsize_Deny
exceeded].
[youcantoo@laptop ~]$

If you see something like this, congratulations,
mailfilter is working properly.
If you see any errors, then you have made a
mistake, so go back and recheck your work. The
above information should have been recorded also
in your mailfilterlog file in your home directory. As
you can see in the example above, all the emails I
received were approved and passed with the
exception of the last one. The reason is that it
exceeded the maximum message size as specified
in the .mailfilterrc file. By default that size is set at
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MAXSIZE_DENY = 1000000. That includes attached
files to the email also!

words Monthly, Unlimited, Increase or combination
of those words that also has Income in the phrase.

For more details of the TAGS used by default in
Mailfilter open a console window and type in
"man mailfilterex"

You can combine the "expressions" to create more
complex filters such as

Adding filters
Adding a spam filter to Mailfilter is actually very easy.
Basically, there are two actions that can be taken:
ALLOW or DENY.
A word of caution!
When you match any filter using DENY that email
will be deleted from the server.
There is NO way to recover these deleted emails. It
is important to always use the TEST flag when trying
out new filters. All ALLOW/DENY entries are logged,
but it only logs a minimum amount of information.
The format is simple.
Example:
Keyword = "expression" The expression could
include any of the following, or combination of
them.
ContentType:
Subject
Body
From
To
Cc
ALLOW = ^From:.@pclinuxos.com
The above filter would allow any email coming from
pclinuxos.com
DENY=^Subject:.*(Monthly|Unlimited|Inc
rease).*Income

This filter will DENY all email(s) that contains the

DENY=^(From|Cc|To):.*(Market(ing)*|Inc
ome).*@(yahoo|hotmail|juno|excite|aol)

This filter will DENY all email(s) with the words
Market, Marketing, and Income or combination of
them from the domains of yahoo, hotmail, juno,
excite and aol. You can find a list of working third
party filters here.
Run Mailfilter using cron
Cron. It's the way to run tasks on a schedule in Unix
like systems. Say, for example, I wanted to run
mailfilter once every minute of every day. Well, we
think of it this way:
Syntax:
minute
hour
command_here

day

month

day_of_week

A quick explanation what it all means:
The first field specifies the minute (0 to 59).
The second field specifies the hour (0 to 23).
The third field specifies the day of the month (1 to
31).
The fourth field specifies the month of the year (1 to
12).
The fifth field specifies the day of the week (0 to 6
for Sunday to Saturday).
The sixth field specifies the command to be
executed.
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So, for a quick example, if I wanted something to run
every night at 3 AM, I would use the following (an
asterisk is the same as saying "anything").
0 3 * * * mailfilter

Or, lets say I wanted every weekday (days 15)
every hour at half past the hour:
30 * * * 15 mailfilter

Or, every 10 minutes (which is what I use):

For those that are console window impaired, there is
a GUI program in the package manager to handle
cron. It is a GUI program, called VCRON. It is in the
PCLinuxOS repository, so you can install it via
Synaptic. You can also use Gnome Schedule, which
is also very good at setting up cron jobs.
1. Open a console window.
directories

to

[root@workbox dwmoar]# cd
/var/lib/spool/cron <press
return/enter>
[root@workbox cron]#

3. Now enter the command "touch yourusername."
[root@workbox cron]# touch <yourusername>
<press return/enter>
[root@workbox cron]#
This will create a file called yourusername.
4. Now we want to add our information to this newly
created file. For this, were are going to use the text
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10,20,30,40,50 * * * * mailfilter

If you are changing Mailfilter's settings while it's
active, nothing special will happen. All changes you
make in the rcfile will be considered next time you
run Mailfilter.

5. Now, we want to save our file and close nano.
Press the "CTRL + X. you should see the following
at the bottom of the screen:

6. You have 3 choices "Y" "N" or "C". Press "y." It
does not matter if it is upper or lower case.

How do I set it up a cron job on my system?

change

your ISP to recover this message for you, though I
doubt this would be a very successful undertaking.

Save modified buffer (ANSWERING "No" WILL
DESTROY CHANGES) ?

10,20,30,40,50 * * * * mailfilter

2. As the root user,
"/var/lib/spool/cron."

editor called nano. Still being the root user enter the
command "nano yourusername." This will open the
file, and you should be greeted with a blank screen.
Assuming that we are going to run mailfilter every 10
minutes, we would enter the following line:

7. You will now see something like this.
File Name to Write:
should be your username

dwmoar

<this

8. At this point, press return. The nano window will
close and you will be returned to the command
prompt. Now mailfilter will run automatically every 10
minutes.

If I make changes to the Mailfilter rcfile, does it affect
immediately?

Sometimes a few (spam) messages slip through.
How come?
This is not a bug in Mailfilter. Consider this a feature
of every POP email server. Once you start checking
for spam or downloading messages, the server locks
your mailbox. If new messages arrive during the
locked state, they will be queued and provided for
further processing after the lock has been removed.
So Mailfilter does not see incoming messages while
it checks for spam and sometimes it happens that a
message or two arrive just in time to be too late for
filtering, but in time for download. That's life.

Be sure that you check the "TEST" flag in your
.mailfilterrc file. If it is set to "yes," the Mailfilter
program will only simulate filtering of your email. If
you are sure that your filters are working properly,
then change this flag to read "Test = off"
FAQ's
I think I accidentally deleted an important email with
Mailfilter. Can I get it back somehow?
Once Mailfilter has deleted an email, all you get to
see of it is where it came from, what it was about
and when it was sent. Have a look in your logfile
(mailfilterlog) and ask the author to send it again. If
that's not an option for you, you may want to ask
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Graphics Tutorials: GIMP, Part 7
by Meemaw
We see text reflections all the time. I think they are
pretty neat, and I always wondered how it was done.
This tutorial will show you a simple text reflection.
Open a new image (I made mine 400x300), select
the Text tool from the Tools Dialog, choose your font
and type in a word. If you want, you can rename the
Text layer to Main Text or it will end up being named
using the text you typed. In the layer dialog tick the
Lock Alpha Channel.
We want to put a
border around our text.
In creating smooth
outlines, we want to
use the text as a
guide.... to do this,
rightclick on the Main
text layer and select
Alpha to Selection.
Then go to Select >
Grow to access the
Grow Selection dialog
or you can rightclick on top of the Text and in the
menu click on Select > Grow. I added 2px for the
Grow Selection.

Click on Create New Layer, name it Border and fill
it with a darker color using the Bucket Fill Tool,
then place it behind the Main Text layer to become a
border.
Now we want to create the reflection effect. First,
rightclick on the Border Layer and in the menu click
on Duplicate Layer. Move the layer on top of the
Main text layer by clicking the up arrow in the Layers
Dialog box. Do the same for the for the Main text
layer and move it on top of the border Copy layer.

Rightclick on the Reflection layer and in the menu
click on Add Layer Mask, selecting Black Full
Transparency, and then click Add. Your reflection
will disappear.

Now merge the two new duplicated layers by right
clicking on on the Main Text Copy layer and in the
menu click on Merge Down. Now rename the layer
Reflection.
Before we do anything else, deselect any selected
layer by going to Select > None. We want to be
working with only the reflection layer, and this makes
sure nothing else is selected.
Using the Move tool, place the the new duplicated
text logo image below the original text logo. Choose
the Flip tool, make sure it’s on Vertical mode, then
drag upwards to finally flip it, or select Layer >
Transform > Flip Vertically. Make sure they are
lined up the way you want them.

Grab the Blend tool and select the FG to BG (RGB)
Gradient and apply it to the reflection from bottom to
top. Make sure your foreground color is black and
the background color is white.

Where you start and end your gradient determines
the visibility of your reflection. Starting at the bottom
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of your reflection text and going to the middle of your
main text results in a bigger reflection (below, left).
Starting in the middle of the reflection text and going
to the top of your main text results in a much smaller
visible reflection (below, right).

Experiment with it until you get what you want
(remember <CTRL> + Z is the key combination for
Undo). When you get your reflection the length you
want it, you can always play with the transparency of
that layer to make the reflection lighter.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!

Screenshot
Screenshot Showcase
Showcase

This can be as simple or fancy as you want. Make
sure your Main Text editing is finished before you do
the reflection.
Have fun!

Answers to Mark Szorady's Double Take

(1) Wizard's clothes missing stars and moons; (2) Book
missing title; (3) Table legs shorter; (4) Wizard's beard
longer; (5) Stool missing leg; (6) Pitcher missing
water; (7) Bowl facing opposite direction
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Forum Foibles Follies
Act I

MP3

OGG

Let me entertain you Let me make you smile
Listen as I sing of the latest thing
You will like its style
It will always please you
I would never tease you
Thousands on it rely
Let me entertain you
And PCLOS you will try yes sir
It's the best you can't deny
Let me entertain you Let me tell you why
I'll tell you some stories of Sandbox glories
I've got a good supply

ACT
I
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Crazies you will find there
But they're always kind there
On that you can rely
Let me entertain you
And PCLOS you will try yes sir
It's the best you can't deny
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Forum Foibles Follies
Act II

MP3

There's no OS like our OS
Like no OS I know
Everything about it is perfection
OGG Everything is really first rate
All the users give it such affection
For every update they cannot wait

ACT
II
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There's no forum like our forum
The folks in it are great
Even if you forget to search
They'll never leave you in a lurch
PCLOS we love it so
Let's go on with the show
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Act III

MP3

OGG

The moment he walked in the forum
We could see he was a man of distinction
A real Linux maker good looking one of our kind
Say wouldn't you like to know what's going on in his mind
So let us get right to the point
We want an OS we know that we can trust
Hey Texstar make a little OS for us

ACT
III
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Wouldn't you like to have fun fun fun
Come to the Sandbox for laughs laughs
We will show you a good time
Let us show you a good time
So let us get right to the point
We want an OS that won't give us any fuss
Hey Texstar make a little OS for us
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Forum Foibles Follies
Act IV

MP3

OGG

ACT
IV
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PCLOS made by Texstar
No flops always tops what an OS czar
PCLOS Lord there's nothing finer
It was meant for you always something new
Man it's oh so true tell the rest adieu

Download that source code it's a real hot number
PCLOS it's the best what an up and comer
Everybody knows it you'll be glad you chose it
PCLOS made by Texstar
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International Community
PCLinuxOS Sites

LinPC.us

Netherlands

Screenshot
Screenshot Showcase
Showcase

Turkey
Denmark

Czechoslovakia

Italy

Poland

Brazil
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Posted by GermanTux, December 2, 2012, running KDE4.
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Nexus 7 To PCLinuxOS Connection Guide
by horusfalcon
I’ll start off by offering a disclaimer: this article is
based on my own personal experiences, and does
not purport to be the definitive allinclusive solution.
Your results may vary wildly  in fact, I hope they do,
as this article is still very much a workinprogress.
Greetings from the North Pole, and Ho! Ho! Ho!,
Everyone! I hope some of you have found a tablet
under the Christmas tree this year. Having recently
become the proud owner of a Google (Asus) Nexus
7 Tablet myself, it was only natural that I would
sooner or later want to transfer files to it from my
PCLinuxOS laptop (a Dell Latitude D620 running
PCLinuxOS 2012.08 Maintenance Release with both
KDE4 and LXDE desktop environments loaded).
First, I just plugged the USB cable into the laptop,
and then the tablet, hoping they would simply
connect up and go. I should be so lucky! All I saw
was the notification from my tablet that it was now
connected as a media device.
“Oh,” I said to myself, “Let’s see if Clementine can
read from it.” Nope. Okay, so it’s time to hit the
books (or at least the big virtual book that is the
World Wide Web). After some fiddling about, and
some reading, and some more fiddling about, here’s
what I’ve come up with:
Connecting via USB Cable
The Nexus 7 comes with its own very nice little USB
cable. This cable is capable of not only charging the
device via a computer’s USB ports or the included
USB charger, but is also capable of transferring
data, once a few things are known to the user.
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Caution: The miniusb port on the tablet is quite
small. Don’t force the cable in  go gently and if it
doesn’t fit easily, take another look and try again.
This precaution is a good one to follow with all
cables and connectors, but especially here.

You will, of course, wish to substitute the path you
create on your system for the one I have used
above. To unmount, close all applications using or
viewing data on this path, and issue the following
command from the shell prompt (all on one line):

Since the device mounts as a media device by
default (and it can also be selected to mount as a
camera), the tools to use for mounting and
dismounting the tablet for access are mtpfs (for
mounting) and fusermount u (for unmounting).

[xxx@locahost ~] fusermount u
~/000_USB/Nexus_7

On my first attempt, I set up a folder at
~/media/Nexus_7 (read the ~ character as “the
current user’s home directory”). I naturally reasoned
that since ~/media/ is the usual path for removable
storage devices, it might be best to mount the tablet
somewhere on that path.
This worked the first time I used it, but did not on
subsequent tries. Rather than figure out why that
was true, I chose to create a new mount point at
~/000_USB/Nexus_7 (which is away from the
removable devices tree) and try again. This has
worked more consistently but seems to be a bit slow
loading data from the tablet. Creating this mount
point was easy from within a file manager (e.g.
Dolphin, PCManFM) or can be done from the shell
as:
[xxx@localhost ~] mkdir ~/000_USB/Nexus_7

Avoid spaces and “special” characters in the
pathnames for a mount point to avoid unnecessary
complications.
To mount the tablet, I open a shell in a terminal, and
issue the following command:

Once the mount point is created, the sequence of
events to transfer files goes something like this:
1. Connect the Nexus 7 to a USB port on your
system via the cable supplied with the unit.
2. Open a shell (via Konsole or other terminal
program) and issue the mounting command as
above, edited for your path (mtpfs).
3. Minimize the shell (or move to another virtual
desktop) and leave it open.
4. Open your favorite file manager.
5. Use cut/copy/paste commands to move data as
needed between the Nexus_7 and the rest of your
system.
6. Wait for all file transfer operations to completely
finish.
7. When done, close all file manager and other
programs which are accessing or viewing the Nexus
7’s files.
8. Restore the shell (or move to it if on another
desktop) and issue the unmounting command as
given above, edited for your path (fusermount u).

[xxx@localhost ~] $mtpfs ~/000_USB/Nexus_7
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9. At this point, it is permissible to disconnect the
tablet from the USB port. (You may leave it
connected if you need for the tablet to charge.)

Install the application from Google Play in the usual
manner and start it on the tablet. Airdroid will display
a passcode near the bottom of the screen.

NOTE! When you issue the fusermount u
command, you may see a message stating that the
device is busy. If this happens, check to see that no
other program on the computer is still
accessing/using the tablet (file managers are the
most common culprits here). If nothing else is using
the tablet, there may be some cached data that
hasn’t yet been written to it. To be safe, shutdown
the computer in an orderly manner and remove the
tablet after the system is powered down. During
shutdown, the operating system will flush its caches
and do any pending writes so that all files on the
tablet will be properly finished and closed out.

Above the passcode are instructions to visit either a
URL or an IP Address and port number on your
wirelessly connected system. I have had best results
with the URL. For better functionality, I recommend
using the Chromium browser (available in the
Synaptic repositories for PCLinuxOS), as certain
folder operations are not supported in Firefox or
other browsers.

During file transfers by this method, I receive an
error message for each file as seen below:

The URL to enter into Chromium’s address bar is:
http://web.airdroid.com as shown at right. Note:
numbers in the passcode are shown in grey text.
(This helps tell a zero from the letter O.)

Here’s a shot of the Airdroid welcome screen
(bottom, previous column). Note the password field
in the lower right. Click there before trying to enter
the passcode.

Once the passcode is entered and a connection is
established, the screen on the tablet will change to
show the connection is working.

Despite the permissions issue, all video and image
files (photos, etc.) are viewable and editable on the
tablet. (I have yet to figure this part of it out  it is
probable that I need to alter the permissions on the
mount point in some way?)
Connecting The Tablet Wirelessly Using Airdroid
Airdroid is a free application available at the Google
Play store. To be able to use it, your tablet and the
computer with which you wish to exchange data
must be on the same wireless network. (I have had
intermittent success with a laptop connected via
Ethernet to my wireless router, but results are
definitely not consistent unless both devices are
connected wirelessly. Again, your mileage may vary.)
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The airdroid client in Chromium will update to display several icons, one of which
is Files.

Doubleclicking this icon will open a file upload/download window in the client
from which files may be moved to and fro.
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In the following screen, I have selected my /sdcard/Movies/ folder as the
destination for uploading from my laptop to the tablet. I choose to use the “Select
Files” button rather than do dragndrop as I feel it’s a safer way to move files,
but that’s just me.

When the “Select Files” button is clicked, a PCManFM window opens on my
system (you may see Dolphin or whatever file manager is your default depending

Page 35

Nexus 7 To PCLinuxOS Connection Guide
on which desktop environment you are running.) The screenshot (bottom right,
previous page) shows that with file names blurred out.

Now close the window or tab in Chromium for the Airdroid client on the computer.
This completes file transfer operations.

The next shot shows the upload dialog with progress bar indicating the file I
selected is uploading. It is also possible to upload multiple files simultaneously
by the usual selection methods in this window.

There are other things that can be done from Airdroid, but I have not yet had
opportunity or need to try them, and so, can’t comment.
Summary
Of the two methods I give here, direct cable connection is the faster. Neither
method is as reliable nor as simple as I would like yet, but they do work with
patience and a little persistence.
While I’m wrapping up, let me just mention a few Android apps I am finding I
can’t live without:
1. Airdroid  a free file transfer app, which I’ve just scratched the surface on
here.
2. MX Player  a free video player that rivals any I’ve seen for versatility and
ability to play darn near any format or encoding. (Hasn’t failed to play even
anime’ vids with Hi10P encoding!) {Note: ad supported, but not too heavy
handed.}

Once file moves are completed, exit from the Airdroid app on the tablet. (Press
the back button at the bottom of the tablet’s window to bring up the “Exit
Airdroid?” dialog and tap Yes to exit.)
The screen on the client will update to show the following message:

3. Olive Office Premium  a free office suite that is capable of editing and
viewing Microsoft Office files (which I can’t avoid using at work!) Note that if you
don’t need editing ability, they also offer a vieweronly product (Olive Office
Basic) that is optimized for viewing. Both handle PDFs well, too.
4. File Expert  a free file manager with lots of features.
5. File Commander  another free file manager I like a lot.
6. Business Calendar Free  a free calendaring app that links in nicely to your
Google Calendar. Can do multiple recurring events, and multiple reminders on
events.
7. Linux Pocket Guide  under $3.00 from O’Reilly Media, this is a handy app
mimicking their popular backpocket guide to everyone’s favorite free operating
system. (Be careful searching for this one  there’s also a book that goes for just
under $7.00 with the same content as this app.)
8. Linux/Unix manpages  just what it says. Very useful, and yes, it is free. Who
says there’s no such thing as Santa Claus?
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9. Fantasy Defense  I couldn’t wrap this up without
a game to kill time between kernel compiles, now
could I? Fantasy Defense is a completely free and
free to play tower defense game which uses anime’
characters (always a big plus for me). It is addictive,
richly appointed with stunning graphics, complex
levels, and a wide variety of advancements and
upgrades all available ingame. You can spend
money to buy items, mana or gold points, but the
game is completely playable (and winnable) without
doing that, and it’s actually rather fun. Free for the
downloading, as are all my picks here.
All of these are available at the Google Play store.
Go get ‘em, kids! They’re cheap! (Most of them are
free!).
My next experiments will involve transferring data
using an OnTheGo cable and a USB flash drive.
I’ve heard it can be done, and might be even simpler
than these two methods. If so, I’ll do a followup at a
later date.

Connect

Visit Us On IRC

• Launch your favorite IRC Chat Client software
(xchat, pidgin, kopete, etc.)
• Go to freenode.net
• Type "/join #pclosmag"
(without the quotes)

Reach Us On The Web
PCLinuxOS Magazine Mailing List:
http://groups.google.com/group/pclinuxosmagazine
PCLinuxOS Magazine Web Site:
http://pclosmag.com/

PCLinuxOS Magazine Forums:
http://www.pclinuxos.com/forum/index.php?board=34.0

Screenshot
Screenshot Showcase
Showcase

All your
PCLinuxOS
connections in one
convenient location!

Posted by menotu, December 20, 2012, running KDE4.

PCLinuxOS Magazine

Page 37

Just The Fax, Ma'am ... And It Works In Linux!
by Paul Arnote (parnote)
I know what you’re thinking … faxes are “old school.”
Faxes are “so 1980s.” Nonetheless, the business
community has tightly hung onto faxing as a part of
their business model. Indeed, many business still
rely heavily on faxes. For them, it’s as deeply
ingrained as much as the checkout line is at the
grocery store. Plus, unless you are rather savvy with
a flatbed scanner, faxing a document is easy enough
for even the most technologically challenged
individual to muddle through.
Fax software has been around … well … ever since
some bright individual figured out how to bypass the
fax machine and do paperless faxing from a
computer equipped with a fax modem. Yet, for many
Linux users, sending a fax isn’t necessarily the
easiest thing to do – and it has nothing to do with a
lack of fax software. Nope. The problem is that most
computers come with a WinModem. WinModems
are software driven fax modems that … you
guessed it … work especially well with Windows, but
not so good with any other platform.
Understanding the proliferation of WinModems is
easy: they are a very cheap fax modem solution,
and since the vast majority of computers come with
Windows installed (except for your home built
computers), WinModems have pretty much become
the dominant and ”preferred” modem installed in
new computers. Unfortunately, this goes back many
years, so that even the older equipment you might
find lying around – say 10 or so years old – has a
WinModem installed.
Of course, you know the drill. The manufacturers of
the WinModems won’t reveal the technical
specifications for the software that drives the
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modem, using the excuse that they don’t want to
reveal “industry trade secrets” about how their
software works. Damn the proprietary closed
sourced community! Although there are packages in
the PCLinuxOS repository that might help you get a
WinModem up and running, it’s usually a “hit and
miss” (mostly miss) proposition.
I discovered the frustrating reality of WinModems
under Linux a couple of months ago, first hand. My
wife was needing to fax some paperwork back to the
contracted company that the hospital we work for
uses to manage the “short term disability” plan,
when she had to take a couple of weeks off of work
following a minor surgery. Then, a few weeks later,
she needed to fax a LONG medical questionnaire to
the offices of a specialist that her doctor had referred
her to. By the way, my wife is fine. We can’t say the
same for our frustration level after trying to fax all of
the paperwork back to the respective parties.
Never having a need to fax anything during the
entire time (nearly six years) that I’ve been a Linux
user, I never took the time or expended the energy
to setup a fax modem. Like most of you reading this
article, I saw faxes as outdated. Indeed, they are an
outdated form of document transmission, but a
necessary evil when dealing with businesses who
rely on that outdated technology to help run core
parts of their businesses.
Finding A Solution, Part One
I set out to try to find a viable solution to my lack of
“faxability” under Linux. My first attempt was to seek
out one of the many “free” fax services that dot the
internet landscape. If you have limited fax needs and
don’t need to fax very many pages, you might

actually get by using an internet based “free fax”
service.
They all work pretty much the same way. You upload
your document, usually as a PDF or *.docx file, and
the service will fax your document to the party you
indicate (via the phone number you enter for the
recipient). You will then receive an email to inform
you whether your fax was successfully or
unsuccessfully delivered.

However, most of the “free” fax services are ad
based, meaning they place ads on your fax cover
sheet. Also, most of these “free” services limit you to
between three and eight pages per fax, with most of
them placing their limit at the lower end of that
range. If you want to fax more pages than the
“allowed” limit, they all offer a “premium” service.
With the “premium” service, you can pay a monthly
fee to be able to fax up to 200 faxes per month,
coupled with a more generous page limit. There
were only a few “premium” services that would have
allowed us to fax the 21 page medical history forms
back to the specialist doctor.
As you can see from the screenshot from the Fax
Zero web site, the paid service listed is for a “per
fax” premium service. Many others offer other
“premium packages” that allow more pages and a
large number of faxes per month. Most of the
“premium” services cost around $10 per month. Just
enter “free internet fax” into your favorite search
engine, and you will be inundated and overwhelmed
by all the sites offering “free internet fax” services.
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Like I mentioned earlier, I did not have a need to fax
anything in the past six years that I’ve been using
Linux, and probably hadn’t faxed anything from
home in the past 10 years or more. (The last fax
software that I remember using was the old WinFax
v2.0, and if I remember correctly, either Windows 98
or Windows XP had some rudimentary fax software
application that did all I wanted.) I couldn’t see a
good reason to sign up for a monthly service that I
haven’t needed in that long of a period. So, the
internet fax service definitely wasn’t for me.
Finding A Solution, Part Two
Since the internet fax service wasn’t going to
adequately or efficiently resolve my lack of ability to
send faxes, I started searching for another solution. I
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figured, why not take a stab at seeing if I had just
one computer where the WinModem would work? To
be perfectly honest, of the 10 computers I tried, the
WinModem was seen by PCLinuxOS on only four of
them.

that it can be configured to work; it just means that
the device answered the query during the polling of
available hardware. The “Modem” shown in the
above image, by the way, does not work under
PCLinuxOS.

To see if PCLinuxOS can even see the WinModem
installed in your computer, open PCC (PCLinuxOS
Control Center), select the “Hardware” entry, then
select “Browse and configure hardware.” If
PCLinuxOS can even see your WinModem, you will
see an entry called “Modem” in the left hand pane of
the window. Don’t hold your breath, however, hoping
you’ll be able to actually configure and use your
WinModem, even if it can be seen. It’s relatively rare
that they work under PCLinuxOS – or any other
Linux distro. For what it’s worth, I was unsuccessful
at getting any of the seen WinModems on the four
computers configured or running. Just because the
hardware can be seen doesn’t necessarily mean

So, I figured if none of my WinModems were
recognized or useable, why not try to find a modem
that is useable with PCLinuxOS? Believe it or not,
external RS232 serial modems do still exist! That
simple find did surprise me. U.S. Robotics, Hayes,
Zoom, Dynex … they are all still out there selling the
trusty, old school external modems. But looking
around Amazon.com, I also saw USB fax modems.
Given that Linux has a history of excellent USB
support, I figured that a USB fax modem might be
my best bet, despite the fact that I hadn’t realized
that they even existed before I went searching for an
external fax modem.
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How else can I say this? SCORE! Touchdown!
Home Run! Victory Lap! Triple Crown! Not only did I
find an affordable USB fax modem, but the very
description even touted that it was useable and
compatible under Linux. I found the TRENDnet 56K
USB 2.0 Phone, Internet, and Fax Modem TFM
561U (White) for only $22.48, on Amazon.com.

Next, plug in the fax modem to an available USB 2.0
port. While I haven’t tried it yet, I’ve heard reports
that the fax portion of the modem doesn’t work with
a USB 1.1 port. However, the modem will work for
dial up networking through a USB 1.1 port. This
shouldn’t be an issue, except on very old hardware
that does not have USB 2.0 ports. More recent
hardware usually has an abundance of USB 2.0
ports.
You will need to enter the commands as the root
user. So, su to root, then type the first line exactly as
shown above. Enter the next line exactly as shown
below (all on one line):
explained commands to be entered on the command
line. Here are those instructions (copied and pasted,
verbatim, from the user guide PDF):
Linux

Sure enough, on the side of the box it lists Linux as
a compatible operating system!

You can refer the below how to do install Harley
USB Modem under Linux.
$ cat /proc/bus/usb/devices
$ modprobe usbserial vendor=0x1111
product=0x2222 > (1111 & 2222 is VID &
DID)
<TFM561U Vendor =0x0572 product=0x1329>
$ dmesg

Here (top of next column) are the unboxed contents
of that retail package (excluding the CDROM that
contains the user guide, and all the paperwork).
The “installation manual” on the CDROM did make
me laugh, though. The Windows installation section
goes on for 14 pages with baby step instructions.
Meanwhile, the Linux installation instructions take up
less than onehalf of a page, consisting of poorly
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$ minicom s > ( dev/ttyUSB0 *
* 115200/8N1/
save
$ minicom

That’s it. So let me try to help a bit, if I can. First,
unless you are using the fax modem for dial up
networking, the last two commands are not
necessary. Minicom, available in the PClinuxOS
repository, is a terminal based application designed
to help you get connected to your dial up provider.

modprobe usbserial vendor=0x0572
product=0x1329

Next, enter the dmesg command on the command
line. You will have a rather lengthy output. (Note: you
can shorten the dmesg output shown by entering the
command as dmesg | tail n 100 to display only the
last 100 lines of the dmesg output. If you don’t see
what you are looking for, increase the number at the
end of the tail command.) You are looking for
something similar to this:
usb 21: new fullspeed USB device number 2
using uhci_hcd
usb
21:
New
USB
device
idVendor=0572, idProduct=1329

found,

usb 21: New USB device
Product=2, SerialNumber=3

Mfr=1,

strings:

usb 21: Product: USB Modem
usb 21: Manufacturer: Conexant
usb 21: SerialNumber: 24680246
cdc_acm 21:1.0: ttyACM0: USB ACM device
usbcore:
cdc_acm

registered

new

interface

driver
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When you launch efaxgtk, you will notice an icon
placed on your panel. Right clicking on this icon will
grant you access to the most common and useful
controls available in efaxgtk. When you “close” the
efaxgtk main window, the icon remains present and
running in your panel. “Closing” the efaxgtk window
only hides it from your view; it is still running, albeit
in the background. A left click of the mouse on the
icon will cause the efaxgtk main window to
reappear.

cdc_acm: USB Abstract Control Model driver
for USB modems and ISDN adapters

On my computers, this bit of information (fortunately)
appears near the end of the massively long dmesg
output. You are interested in the serial address that
PCLinuxOS has assigned to the USB fax modem.
I’ve highlighted that information above in red. Write
this down. You will need it later when you set up the
fax software. While your computer may report it
exactly as I’ve shown above, don’t count on it. You
may have other USB serial devices plugged into
your computer, which may change the assigned
serial address. DO NOT skip this step.

Before we can use efaxgtk, we first need to set a
few things up. Select File > Settings from the menus.

The only thing you now have left to do is to plug in
one end of a modular phone cord to the other end of
the USB fax modem, and the other end of the
modular phone cord into an available modular phone
jack. A 6 foot (1.8 m) modular phone cord is
provided with the fax modem, but if you’re like me,
you have a thousand of these things lying around
already.
The Software: efaxgtk
Now, you will need to install efaxgtk from Synaptic.
Yes, there are other fax software packages available
in the PCLinuxOS repos, but efaxgtk is simple, easy
to use, and probably better suited for personal faxing
from your home. One of the other fax packages that
is available is called Hylafax, but it is more suited for
use in an enterprise environment and would most
likely be overkill for home use. Thus, we’re going to
focus our attention on setting up and running efax
gtk. If you want the more “technical details” of efax
gtk, you can view the efaxgtk man page online,
here.
Don’t let the simple appearance of efaxgtk fool you.
There’s more power under the hood than you might
think. To be honest, the simple appearance of efax
gtk is one of the reasons I find it such a pleasure to
use. It stays out of your way, yet all the whistles and
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bells are close at hand for when you need them (and
if you even need them). It follows the principle
adhered to by many Linux developers: do one thing,
and do it well.

On the first tab, you simply enter your name and the
number from where you are sending your fax. I’m
not sure about anywhere else, but it is a FCC
regulation in the United States to list the number you
are faxing from on your outgoing faxes. Remember
that serial address I told you to write down when you
were setting up the fax modem? Well, on the second
tab, you will need to enter the serial address that
PCLinuxOS assigned to your fax modem when you
set it up. Enter only the serial address, without any
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preceding slashes or anything else. On the second
tab, you can leave everything else set to the default
settings.

You can, if you choose, skip the next three tabs. The
third tab lists the modem string for initializing the
modem. I found that you can leave this set to the
default values, and that it works as is. The fourth tab
allows you to determine how to print out any faxes
you might receive. I have the “Use GTK+ Print
System” checked. Under the fifth tab, “Print,” you
can set the default application to use when viewing
received faxes. The default is gv, also known as
ghostview, but I have changed mine to “evince,”
since that is the postscript/PDF viewer I use under
Xfce. KDE users may want to change “gv” to
“okular,” allowing them to use the powerful Okular
document reader to view their faxes.
The “Socket” tab is definitely one you will want to set
up. This sets up efaxgtk to listen in on a CUPS
socket (default is 9900) so that you can send a fax
directly from any application that allows you to print.
We’ll cover setting up the socket a little bit later, but
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it isn’t all that hard (once you’ve been introduced to
how to do it). I had to dig through the online efaxgtk
man page to figure it out. To make it easier for you,
make all of your settings mirror what I have entered
on this tab, shown above.

There aren’t a lot of choices under the “Receive” tab.
There, you can choose whether you want efaxgtk to
display a popup window when you receive a fax, and
you can also specify a program or script to execute
whenever you receive a fax. I just told efaxgtk to
display a popup window, then moved on. Under the
“Send” tab (the eighth tab), you can set the fax
resolution you prefer (I always set mine to “Fine”).
You can also check the box to include the
destination fax number on the fax page top header
line. On the third line, you can specify a prefix to dial
before the actual number is dialed. This is
particularly useful if you wish to disable call waiting
before making your call (*70 on most U.S. phone
networks).
In the ninth tab, “Logging,” you can set up where to
write the fax log. I have created mine as a hidden file

in my ~/Documents folder, by placing a “dot” before
the filename, and called it simply .fax.log. Be sure to
create the empty log file before pointing efaxgtk to
it, or otherwise, efaxgtk will complain that the file
doesn’t exist. I strongly encourage you to keep a fax
log. It can be quite revealing if you should ever
encounter errors. A quick look at the log file will spell
out everything that transpired while attempting to
send that fax.
The tenth and last tab, “Page,” allows you to set the
paper size efaxgtk is going to deal with. Your
choices are A4, Letter or Legal. Most U.S. users will
want to choose Letter, while my European friends
will most likely choose A4.
Putting It All To Work
Now that we have efaxgtk all set up, it’s time to put
it to work, doing what it’s intended to do: send and
receive faxes.
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If your fax didn’t send successfully, review the fax
log file to help diagnose any problems you might be
having. You will know if there are any errors when
sending the fax, since they will show up as red text
in the text area that’s in the lower half of the efaxgtk
window. Since all errors – minor and major – show
up in red text, you will need to check to see which
ones are important enough to follow up on.
There are other “fax test” numbers you can use.
HewlettPackard (HP) has a test fax number on their
website. You send a fax to the HP fax test line, and a
return fax will be sent to you in less than five
minutes. This is good, since it also gives you an
opportunity to test how well you are able to receive
faxes.
You can also test your fax modem’s ability to receive
faxes. One way is to head over to Interpage Network
Services, Inc. website and follow the instructions to
have the service send you a fax. Alternatively, you
can go to FaxZero and send yourself a free fax by
entering your phone number into the recipient field.
What’s that, you say? You don’t know anyone to
send a fax to so you can test your fax modem? Ah
ha! That’s an easy solution! There are a couple of
different routes you can take. To start with, you could
find a local friend and send them a fax, via their fax
modem. You could also fax something to your place
of employment (it would probably be best to get your
boss’s OK first, though).
But the best solution I’ve seen (for U.S. users,
anyways) is to dial 18888771655. The number is
toll free, within the United States. Once your fax is
sent, wait a couple of minutes and head over to the
FaxToy website. If your fax was successfully sent,
your fax will appear on their website. Just keep
hitting your browser’s refresh button. They suggest
you send a single page fax only. If you send a
multipage fax, only the last page will show up on the
FaxToy website.
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So, pick which test service you want to use, and let’s
start off by first sending a fax from our fax modem. I
chose the FaxToy service for my initial tests.
Remember that whatever you are sending via efax
gtk has to be in the PDF format (we’ll get to sending
a fax from a word processing document later). Select
the “Single File” button, then select the PDF
document you want to send.
Next, enter the phone number for the fax service you
are using. Do NOT use any spaces or dashes in the
phone number. Once you have entered the phone
number, make sure your fax modem is plugged into
your computer, and that the modular phone cord is
plugged in at both ends (one end to your fax
modem, the other end to a modular phone jack).
Then, just click on the “Send Fax” button and wait
for the process to complete. You should see the
lights on the USB fax modem spring to life and start
blinking madly.

Similarly, to receive a fax, press the “Answer Call”
button in the main efaxgtk window. Your fax modem
should now answer the call and display the
connection data in the text area. In the inadvertent
case that you receive a voice call and you have your
fax modem answer that call, you can click on the
“Take Over Call” button to wrest control away from
your fax modem.
If you’ve done everything properly up to this point,
you should be able to send and receive faxes. If not,
go back and recheck your entire setup, and make
sure you didn’t skip any of the steps that I’ve
outlined. Also check to make sure you entered
everything properly. Just one misspelled command
on the command line would be enough to prevent a
successful setup of your fax modem.
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The “Extras”
As I mentioned earlier, there are many powerful
features hidden under the simple appearance of
efaxgtk. One such nice feature is the builtin
address book. This allows you quick access to
someone that you might want to send faxes to
repeatedly.

Of course, when you first open the address book, it
will be empty. Click on the button with the pencil icon
on it to make an address book entry.

number will be transferred to the telephone number
line in the efaxgtk main window.

Another nice feature built into efaxgtk is the “List
Received Faxes” and the “List Sent Faxes” lists.
Both dialog boxes look identical, except for the
dialog box title on the window title bar. Simply
highlight the fax you want to work with, and choose
whether you want to print or just view the fax, edit its
description, or send it to the trash. You also have the
option to add custom folders and to move your sent
faxes to custom folders, (like for keeping track of
faxes sent to or received from a particular recipient).

You can also send multiple documents/files to a
recipient during a single fax session. Not only is this
handy, but it also makes sense to fax them all in one
fax session, as opposed to having to send each
document as a separate fax. Just click on the “Add
files to list” button at the top of the dialog box, and
select the files you want to include in the fax. When
you’re finished adding files, click the OK button at
the bottom. Your files will be queued for sending.

Under the “Log” menu, you have the option to either
print the log file, or to view the log file. If you choose
the latter, the contents of the log file are displayed in
a dialog box, like that above. Of course, if you
haven’t set up a fax log file under the “Logging” tab
of the efaxgtk settings, you will not have anything to
print out or display.
“Printing” To A Fax Recipient

Enter the name of the contact on the first line, and
the contact’s fax number on the second line. Click on
the OK button, and you will see your fax contact in
the efaxgtk address book. Now, when you click on
the “Tel number” button in the efaxgtk window, the
address book will open. Select your recipient, and
click on the OK button. Your fax recipient’s phone
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As I mentioned earlier, you can set up efaxgtk to
send a fax directly from your favorite word processor
to your fax recipient. In fact, you can do this from
any application that supports printing. Before we can
“print” to a fax recipient, however, we have to set up
our fax modem as a “printer.” Trust me … it’s easier
than it sounds.
To set up our fax modem as a “printer,” we need to
install a new printer in the PCLinuxOS Control
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Center, a.k.a. PCC. If you have not yet installed
taskprinting from Synaptic, now would be a good
time to do so, before proceeding any further.

Under the “Hardware” tab in PCC (in the left pane),
click on the “Configure printing and scanning”
section (in the right pane, as shown above). Once
you get to the next window, click on the first icon on
the toolbar to bring up the “New Printer” dialog box.
Once at the screen above in the PCC New Printer
Wizard, accept all the defaults and simply click on
the “Forward” button.

In the first window of the “New Printer” wizard, select
“Other” in the left pane of the window. Then, enter
socket://localhost:9900 as the URI entry. Click on
the “Forward” button. A smaller dialog box will open
to inform you that PCLinuxOS is searching for
drivers. Let it run until the next screen appears.

Once again, accept all the defaults in the window
above, and simply click on the “Forward” button.
You can accept the default values here, but I would
make a suggestion that you change the name and
description to something simple, like “Fax.”
Otherwise, it won’t be apparent that this is the fax
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“printer” in the list of available printers. If you choose
to not change them now, you can change them later
in the PCC Printer Configuration window. All you
have to do is highlight the printer whose name you
want change, press F2, and type in the new name –
just like changing a filename in your favorite file
manager. Click on the “Apply” button to finish the
setup of your fax modem as a “printer.”

If you right click on a printer in the Printer window of
PCC, you can select “Properties” from the pop up
context menu. When you click on the fax “printer”
icon, you will get a window similar to that shown
above. You can make changes to the description
and location of the printer here, too.
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Select the “Policies” category of printer properties.
You will find that “Shared” is checked by default.
Click on the checkbox to deselect the check mark for
sharing your fax modem. This will keep the fax
modem exclusive to the machine that you have it set
up on, and help you to avoid conflicts with CUPS
wanting to share your fax modem over your entire
home network. Also, if you have multiple computers
in the house and you set up the fax modem on
multiple computers, having them all shared will make
multiple entries for the fax modem appear on all of
your computers. You won’t know which fax printer is
for the local machine! Take it from me that neglecting
to unshare the fax modem is problematic, and this is
the easiest solution.

Click on the “Tel number:” button to select a number
from efaxgtk’s address book, or manually enter the
fax number in the space provided. Then, click the
“Send fax” button. From this point on, efaxgtk will
take care of faxing your document to the selected
recipient.
Things To Keep In Mind About Faxes
Like we mentioned at the beginning, faxes are an
old, archaic technology. Some of the limitations of
faxes are ruled by a couple of factors. First, there
are the speed limitations of the POTS/PSTD
telephone network. Second, the fax “standard” has
become static, and in the process, hasn’t kept up
with technological advances. Part of the second
factor is due to the first one. They are inextricably
linked, to a large degree.
The second thing to keep in mind about faxes is that
the fax world is a black and white world. Color
images will get dithered to black and white, so that
your fax ends up as shades of gray that are made
up of black dots on a white background.

Now that you have the fax “printer” installed, you
notice that “Fax” shows up in your list of available
printers. Simply select “Fax” as your printer, and
click on the “Print” button.
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Third, faxes are inherently low resolution. Even the
“fine resolution” setting is, maximally, only 200 dots
per inch. Below are some examples of how a “color”
document gets dithered, and the resulting resolution
that your recipient sees.

On the left is a snippet of the original color image. In
the middle is a snippet of the dithered TIFF image
that makes up the outgoing fax. On the far right is
the low resolution image that was placed on the
FaxToy website. Looking from left to right, the direct
comparisons above make it easy to see the quality
loss from the original to the lower resolution images
that your recipient receives.
Some “Cleanup” Tasks
When you installed and first ran efaxgtk, you will
notice that it also created some special folders in
your /home directory. Below is a snippet of those
directories, as they appear in Thunar on my Xfce
installation.

You will notice four folders that have “fax” as part of
their names. Let me explain what is in each one. In
the “efaxgtkserver” folder are postscript files
containing a copy of what was transmitted by efax
gtk using the “socket.” The “faxin” folder contains
TIFF copies of incoming faxes that you have
received. The “faxout” folder contains TIFF copies of
faxes that are in the process of being sent. Finally,
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the “faxsent” folder contains TIFF copies of faxes
that have completed sending.
TIFF (Tagged Image Files Format) files, if you’re not
familiar with them, aren’t necessarily the smallest
image file to store. I suspect that they are used
because they are capable of storing and maintaining
images at a high resolution. TIFF files may or may
not employ LZW compression. LZW compression
will make them consume less space, but will make
them take longer to display. TIFF files may also
contain multiple images within the TIFF “container,”
which initially makes them appear to be a single
image. Because of the amount of space these files
consume, you may wish to periodically clean out old
files from these folders that are no longer needed.
One other “house cleaning” chore you may wish to
perform is to periodically pare down the fax log file,
especially if you do a lot of faxing. Since the most
recent log information is appended to the end of the
fax log file, you will want to trim it down from the
beginning of the file. An ordinary text editor (KWrite,
Mousepad, Leafpad, Geany, etc.) can be used to
edit down your fax log file. If it is important to you to
keep records of your fax activity, you may want to
print out the fax log before you trim it down.
Otherwise, there is no other reason to keep records
of your fax activities even several months after the
fax has been sent.
Are There Alternatives?
Yes, Virginia. There are better alternatives to faxing.
The main alternative is to create PDF files, (either by
printing to a file or by scanning documents with a
flatbed document scanner), and email them to the
recipient. Email is faster, more reliable and a lot
more efficient than faxing. Even some of the more
advanced office copiers can create a PDF file that is
emailed to the recipients, rather than sending them a
fax. The added benefit is that your recipient not only
gets a document at a much higher quality, but they
can also receive color images within the PDF file.
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Because of one fiasco that we recently encountered,
(the “Time Off From Work” contractor’s fax machine
was “messed up” and we made 26 attempts to fax
the required paperwork back to them so that my wife
could return to work), I now ask for an alternate
email address I can simply email the PDF file to.
Even my 300 dpi scans from my flatbed scanner
have much better resolution than the paltry 200 dpi
maximum resolution of a received fax. I also used
this method to send pictures taken during my wife’s
laparoscopic surgery to the specialist doctor,
scanning the images and putting them into a PDF
file.
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All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
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Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
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Summary
As you can see, it’s not difficult to gain fax
capabilities under Linux – provided you have the
right equipment. Although fax technology is old,
slow, inefficient and archaic, it remains firmly rooted
in the business community. Because of that
entrenchment, faxing remains a necessary evil for
the rest of us have to endure, despite its limitations.
Not all of your fax recipients are going to be willing
to provide an email address to receive a alternate
email from an untrusted and unknown user. They
will, most likely, be running Windows and will be
afraid of viruses in received files. It also doesn’t help
that Adobe (who “invented” and drives the PDF
format) has a muchlessthanstellar reputation with
“security vulnerabilities” in their proprietary file
formats. The best we can do is to make our use of
faxes as painless as possible. The ability to use a
fax modem on Linux does remove some of the sting.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.
Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.
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The place where breaking news,
BitTorrent and copyright collide

Screenshot
Screenshot Showcase
Showcase

It's easier than E=mc2
It's elemental
It's light years ahead
It's a wise choice
It's Radically Simple
It's ...

Posted by agmg, December 16, 2012, running KDE4.
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Game Zone: Zombie Driver HD
Hardware:
Processor: 1.5 GHz dual core
Memory: 512 MB
Graphics: 120 MB Directx 9.0c compatible or better
with pixelshader 3.0
Hard Drive Space: 2 GB
Sound: Directx 9.0c compatible.
These are the minimum requirements for Windows
7/Vista/XP. However, I have always had better luck
when these specs are slightly higher, on account of
playing through WINE.
About The Company

by daiashi
About the game
Zombie Driver is basically a car crazed zombie
smash game where you fight your way through the
streets of a city that has become infested with a
zombie outbreak. Your mission is to save the
survivors of a chemical accident that turned most of
the city’s population into brain crazed monsters. You
will drive several different vehicles on your way to
completing your missions. There is also a blood race
if you get tired of the missions. You earn cash in this
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mode as you battle other vehicles, while at the same
time running down zombies. If that is not enough to
get your zombie on, there is also slaughter mode
which is similar to survival mode on other titles,
where you try to last as long as you can.
http://www.zombiedriver.com/

Exor Studios is a game development company
founded in August, 2007, and based in Szczecin,
Poland. Its developers have extensive experience in
developing games for Microsoft’s Xbox 360, the PC
(Windows platform), and mobile platforms. Formerly,
EXOR Studios key personnel have worked with
gaming industry giants, such as EA Mobile, Nokia,
Namco and Sony Online Entertainment.
Some Gameplay Screenshots

System requirements
Software:
Wine and steam.
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running, type “zombie driver” in the search bar within
Steam to quickly locate it.

After you download it, let it install. You will have to
do just a few things to get it running. At least, this is
what worked for me. At first, the program would not
start, until I manually used the directx.exe here.

Getting It To Run
Ok, first things first. Head on over and grab Steam.
WINE should install it without any problems, as the
WINE team has made lots of progress from where
they used to be. Once you have Steam up and
Second, open up WINE configurator here, and add
d3dx9_36 and dedx9_38 to the libraries. Be sure to
set them both to (native, built in).
Advertisement
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When you first start the game, you will be given
some settings from which to choose. Make sure you
turn Bloom:off and Clouds:off to help the stuttering
that’s sometimes present. Well, that’s about it, so go
hit the streets and kill some zombies.
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Adding ‘Play Folder Content As DVD Video In SMPlayer’
Entry To KDE Actions Service Menu
by AndrzejL

Actions=PlayWithSmplayer;
Name=Play content of this folder as
DVD video in SMPlayer.
GenericName=Play content of this
folder as DVD video in SMPlayer.
Icon=/usr/share/icons/hicolor/64x64/
apps/smplayer.png
ServiceTypes=ServiceTypes=KonqPopupM
enu/Plugin
XKDE
ServiceTypes=KonqPopupMenu/Plugin,in
ode/directory
[Desktop Action PlayWithSmplayer]
Name=Play folder content as DVD
video in SMPlayer.
Exec=smplayer 'dvd://1//%U'
Icon=/usr/share/icons/hicolor/16x16/
apps/smplayer.png

I have a bunch of folders on my hard drive
containing DVD videos. These are family videos
from Christmas, weddings, baptisms and other
occasions recorded with my camcorder in DVD
format, and then backed up to my HDD. I could
rip them into .avi files just to make it easier to play
them, but then I am risking losing the quality of
the originals. It would be pointless, really –
recording in DVD quality just to encode it to avi. If
not the waste of quality, then definitely a waste of
time and cpu power/electric energy.
Anyway, as you probably know, DVD video
content is a whole structure. It’s not just one file,
so it’s not as easy as going into the file’s folder
and clicking on it to make it playable. There are
.vob files inside that could be played one after
another. Sure, but it’s a waste of time. Plus, each
DVD has at least two to four of those .vob files.
You would have to click on each of them to watch
the entire video, and sometimes the rewinding or
fast forwarding won’t work when you do that. Nah.
That won’t work for me.
When you right click on something in KDE4, you get
a context menu and one of the items in this menu is
‘Actions’. I have decided to add ‘Play content of this
folder as DVD video in SMPlayer’ entry to this menu
in PCLinuxOS KDE4.9.2. It took me a while, but I
have succeeded. Here is how you do it.
First, make sure you have SMPlayer installed. Under
PCLinuxOS 2012.08, VLC was set up as the default
media player, so you will probably have to install it
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Now save the file. There. You’re all done.
from Synaptic. After you install SMPlayer, open a
terminal session and run these commands (each on
one line):
mkdir p
~/.kde4/share/kde4/services/ServiceMen
us/
kwrite
~/.kde4/share/kde4/services/ServiceMen
us/playwithsmplayer.desktop
Then, paste this into Kwrite:
[Desktop Entry]
Type=Service
Version=1.0

Right click on any folder containing a DVD
structure and choose Actions > Play folder
content as DVD video in SMPlayer from the menu.
SMplayer will start and will start playing DVD from
the folder that you have chosen.

Want to keep up on the latest that's
going on with PCLinuxOS?
Follow PCLinuxOS on Twitter!
http://twitter.com/iluvpclinuxos
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More Screenshot Showcase

Top Left: Posted by ff103, December 2, 2012, running KDE4.
Bottom Left: Posted by Jim Dandy, December 1, 2012, running KDE4.
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Top Right: Posted by RobNJ, December 8, 2012, running e17.
Bottom Left: Posted by ferry_th, December 20, 2012, running Openbox.
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